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FTRestore 

FTRestore is a Windows desktop application designed to upload, download and compare memory 

channels and menu settings in the Yaesu FTDX1200, FTDX3000, FTDX5000 (experimental), FT-891 

(experimental) and FT-991/FT-991A model transceivers.  Details of the Regular Memory Channels, 

PMS Memory Channels and the Menu Settings can be uploaded from the transceiver into a 

worksheet grid control where they can be modified as required, before being saved in a Microsoft 

Excel compatible file or a Menu Settings file.  The files can be opened later and have the memory 

channel and menu settings details downloaded again to the transceiver.  There is also the ability to 

compare the memory channels and menu settings in FTRestore with the transceiver to detect any 

discrepancies before uploading or downloading. 

As far as saving, restoring and comparing memory channels and menu settings, there is no 

difference in behavior on the part of FTRestore.  So, unless otherwise noted, any reference to the 

model FT-991 transceiver in this document can be assumed to apply equally to the FT-991A model. 

The author does not have access to either an FTDX5000 or an FT-891, so all beta/functional testing 

has been done by other remote users.  All defects identified during that testing have been fixed, but 

FTDX5000 and FT-891 owners should still consider this release somewhat experimental at present. 

Features 

• Memory Channel worksheets can be saved in Microsoft Excel 97-2003, Excel 2007, Excel 

2010 or Excel 2013 file format for your convenience. 

• Memory Channel worksheets can be read from any version of Microsoft Excel 97-2003, Excel 

2007, Excel 2010 or Excel 2013 file format. 

 

NOTE: Microsoft Excel is only required if you choose to edit the Memory Channel 

worksheet outside of FTRestore.  The FTRestore Memory Channel worksheet grid 

can be used to edit all details in the worksheet without having to use any other 

program. 

 

• The FTRestore application can have multiple Memory Channel worksheets opened at the 

same time with the model of transceiver (either FTDX1200, FTDX3000, FTDX5000 or FT-991) 

being automatically detected. 

• The memory channel details can be uploaded from the transceiver on the COM port 

associated with the currently selected tab into the Memory Channel worksheet. 

• The memory channel details can be compared to the transceiver on the COM port 

associated with the currently selected tab to the details in the Memory Channel worksheet. 

• The memory channel details can be downloaded to the transceiver on the COM port 

associated with the selected tab from the details in the Memory Channel worksheet. 

• The antenna selection (Ant1, Ant2, Ant3*, Ant4** or Ant Rx**) can be saved and restored 

with each memory for the FTDX1200, FTDX3000* and FTDX5000** transceiver. 
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• The CTCSS Tone Frequency can be saved and restored with each memory in the FT-991 

transceiver. 

• The Menu Setting details can be uploaded from the transceiver on the COM port associated 

with the currently selected Memory Channel worksheet tab into to the Menu Settings 

dialog. 

• The Menu Setting details can be compared from the transceiver on the COM port associated 

with the currently selected Memory Channel worksheet tab to the details in the Menu 

Settings dialog. 

• The Menu Setting details can be download to the transceiver on the COM port associated 

with the currently selected Memory Channel worksheet tab from the details in the Menu 

Settings dialog. 

• The Menu Settings details can be saved in one or more files with a file type extension 

appropriate for each model transceiver. 

• There are multi-level Undo/Redo editing capabilities in both the Memory Channel worksheet 

grid and the Menu Settings dialog grid.  Each grid has its own Undo/Redo stack and clipboard 

for complete isolation of changes being made in each grid. 

• Time and Date (if applicable) can be set in the FTDX1200, FTDX3000, FTDX5000 and FT-991 

transceivers. 

• FTRestore will record the filenames of all currently opened Memory Channel worksheets and 

their associated COM ports when the application is closed.  The next time the FTRestore 

application is run it will automatically re-open and display the previously saved collection of 

worksheets, and it will also attempt to identify and connect to the transceivers plugged into 

the COM ports associated with each worksheet. 

• FTRestore will record the filename of the last saved Menu Setting file for each model 

transceiver when the application is closed.  The next time FTRestore application is run, and 

the Menu Settings dialog is opened for any model transceiver, the last used Menu Settings 

file for that model transceiver will be automatically re-opened and displayed in the grid. 

 

NOTE:  This is an ongoing piece of work and is not intended to be a commercial venture.  FTRestore 

is free to use although we may ask for a small contribution sometime in the future to help defray the 

costs of web hosting, maintaining the software and adding new features if sufficient interest is 

shown by our fellow amateurs.

System Requirements 

FTRestore is a Windows desktop application that has been designed to use the Microsoft .NET 

Framework 4.5.1 which is supported by Microsoft to run on the following workstation and server 

operating systems: 

• Windows 10 

• Windows 8.1 

• Windows 8 

• Windows 7 SP1 
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• Windows Vista SP2 

• Windows Server 2012 

• Windows Server 2008 R2 SP11 

• Windows Server 2008 SP22 

Windows 8.1 and Windows Server 2012 R2 come with the Microsoft .NET Framework 4.5.1 pre-

installed.  The .NET Framework 4.5.1 will need to be downloaded and installed for the other 

operating system versions listed above if it hasn’t already been installed by other .NET applications 

run on the server or workstation. 

Hardware Requirements3 

Processor: 1GHz  (32-bit or 64-bit) 
RAM: 512 MB 
Disk space (minimum)  

32-bit: 850 MB 
64-bit: 2 GB 

 
1 The .NET Framework is supported in the Server Core Role with SP1 or later but isn't supported on Windows Server 2008 R2 for 

Itanium-Based Systems. 
2 The .NET Framework is not supported in the Server Core Role. 
3 The hardware requirements listed above are those specified by Microsoft for the .NET Framework 4.5.1 itself.  The FTRestore 

application shouldn’t place any additional burden on these requirements. 
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Installation 

1. You can download the latest release of the FTRestore installation program from the FTRestore 

page at http://www.vk2byi.com.au/ftrestore. 

2. After you have downloaded the file, run the installation program. 

3. The installation program will check whether the Microsoft .NET Framework 4.5.1 is installed or 

not.  If the correct version (or later) of the framework is installed, the installation program will 

continue at step 9. 

4. If the correct version of the framework is not installed, the following warning will be displayed: 

 

5. Click on the Yes button to start the installation on the framework.  The following message will be 

displayed: 

 

6. Click on the OK button and the installation program will launch the web browser and load the 

Microsoft .NET Framework 4.5.1 (Web Installer) page from the Microsoft Download Center.  The 

installer program will then close. 

7. You can refer to the Installing the Microsoft .NET Framework 4.5.1 section towards the end of 

this document and return here when it has been installed. 

8. Run the FTRestore installation program again. 

9. If you get a security warning like the following, click on the Yes button: 

http://www.vk2byi.com.au/ftrestore
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10. When the installation continues, it will display the following prompt.  Click the Next button: 

 

11. Read the license agreement and then click the I accept the agreement check box and click the 

Next button: 
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12. Read the release notes to see what has changed and then click the next button: 

 

13. Use the recommended folder as the Destination Folder by clicking on the Next button: 
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14. You can tick the checkboxes to create Start Menu or Desktop shortcuts for the FTRestore 

application as desired, and then click the Next button: 

 

15. You can review your selections at this stage and use the Back button to make any changes.  

Otherwise, click on the Install button to continue with the installation: 
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16. After it has been installed, you have the options to launch FTRestore and/or open the Readme 

file by ticking the checkboxes as you prefer, and then clicking the Finish button: 

 

17. The installation of the FTRestore application is now complete. 



13 

 

Getting Started 

Before starting FTRestore you should check Menu number 41 on the FTDX1200, Menu number 40 on 

the FTDX3000, Menu number 34 on the FTDX5000, Menu number 05-08 on the FT-891 or Menu 

number 33 on the FT-991, as you may have to DISABLE the RTS setting on the CAT port.  It has been 

our experience that this is required for programs such as Ham Radio Deluxe. 

The author has a USB-63 cable that won’t work unless the CAT RTS menu is set to DISABLE on his 

FTDX1200, although a colleague with the same cable and the same equipment can have the CAT RTS 

set to ENABLE and have FTRestore connect successfully with the transceiver. 

In short, it may be prudent to simply set the CAT RTS setting to DISABLE after any Menu Reset or any 

Full Reset of the transceiver to avoid any issues.  We have paid attention to the timing of CAT 

commands being sent so as avoid overrunning the transceiver without flow control being required. 

Starting FTRestore 

The following shows the screen images of an FTRestore session using a Yaesu FTDX1200.  Click on the 

FTRestore desktop shortcut to start the FTRestore application. 

When the FTRestore application is started, a splash screen will display for a few seconds as the 

program initializes after which the main form will displayed: 

 

Select New on the File menu, or press Ctrl+N, to open a new worksheet: 
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The Port Settings Dialog will be displayed.  Select the COM port that is connected to a Yaesu 

FTDX1200, FTDX3000, FTDX5000, FT-891 or FT-991 model transceiver and check that the Baud Rate 

matches the value set in the transceiver (typically 4,800 bps). 

If you have a CAT interface cable that correctly passes the RTS signal through to the transceiver, you 

can set RequestToSend in the Flow control list box setting and leave the CAT RTS menu setting in 

your transceiver set to the default setting of ENABLE.   

 

If this works in your situation, you won’t have to change the CAT RTS setting after a Menu Reset or a 

Full Reset of the transceiver. 

If you need to set the CAT RTS menu setting in your transceiver to DISABLE to work with other software 

such as Ham Radio Deluxe, then set the Flow control list box setting to None. 
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Don’t change the Parity (None), Data bits (8) or Stop bits (1) from the default settings.  Click the OK 

button to open a new worksheet and detect the transceiver model.  

In this case an FTDX1200 was automatically detected on COM4 and a blank Untitled worksheet is 

displayed with the transceiver model and COM port name on the worksheet tab: 

 

If a transceiver cannot be detected, or the selected COM port is in use by another application, the 

tab name instead will be Unsupported on COMn where n is the port number. 

Uploading Memory Channels 

Select Get Memory Channels… on the Radio menu to upload the current memory channel settings 

from the transceiver: 

 

You will be warned that the current worksheet will be overwritten, so click on the Yes button to 

proceed.  As the details are uploaded from the transceiver, you will see a progress bar and any 

occupied memories being filled in as rows in the worksheet in the background.  If you click on the 



16 

 

Cancel button, the upload process will stop at the current point in time and the remaining memories 

will not be uploaded: 

 

At this stage, it would be advisable to save the worksheet as an Excel spreadsheet file before 

continuing as the worksheet now contains the currently programmed memory channels from the 

transceiver.  To save the worksheet select Save As from the File menu, specify a filename and the 

version of the Excel spreadsheet format you wish to write and click on the Save button: 

 

By default, files will be saved in a folder called FTRestore under the current user’s personal 

Documents folder. 
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Changes can now be made to the memory channel details in the FTRestore worksheet grid.  If you 

wish to remove the contents of a memory channel, just highlight the row and press the Del key.  

However, memory channels in the radio can only be removed by deleting the memory from the 

transceiver front panel.  So, remember to clear any individual memories, or perform a full memory 

reset, in the transceiver before downloading a new configuration. 

You can save the changes to the file by selecting the Save or Save As option from the File menu.  

However, before you download the changes, you may want to perform a comparison between the 

current memory channels in the transceiver and the memory channel details in the modified 

worksheet to see the impact of any changes. 

Comparing Memory Channels 

Select the Compare Memory Channels… option from the Radio menu to see if there are any 

differences between the worksheet and the transceiver: 

 

A progress bar will be displayed as the rows in the worksheet are compared to the memory channels 

in transceiver.  If you click on the Cancel button, the compare process will stop at the current point 

in time and the remaining memories will not be compared.  If a difference is detected, a dialog will 

be displayed showing the worksheet values on the left and the transceiver values on the right: 
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In this case, memory channel 002 was cleared from the worksheet, but it hasn’t been manually 

deleted from the transceiver.  Also, memory channel 004 has a different value for the antenna 

selection to that programmed for the same memory in the transceiver. 

The comparison results can be viewed in a Print Preview dialog, or printed, by selecting the 

corresponding option on the File menu in the results dialog. 

Downloading Memory Channels 

Once you have the worksheet modified to your satisfaction, you can download the new memory 

channel details to the transceiver.  Select the Set Memory Channels… option from the Radio menu:  

 

A progress bar will be displayed as the currently populated rows in the worksheet are downloaded 

to the transceiver.  If you click on the Cancel button, the download process will stop at the current 

point in time and the remaining memories will not be downloaded: 

 

Remember, populated rows in the transceiver will only be updated by populated rows in the 

worksheet.  Blank rows in the worksheet will not delete the corresponding memory channel in the 
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transceiver.  So, you may want to delete the individual memories, or perform a full memory reset, in 

the transceiver before downloading a new configuration. 

Importing Memory Channels 

It is possible to import memory channel details from other applications that are used to program 

various transceiver models.  Any one of the following supported CSV files formats can be imported 

into a worksheet associated with either an FTDX1200, FTDX3000, FTDX5000 or FT-991 model 

transceiver: 

• RT Systems ADMS-DX1200 (FTDX1200) - Version 4.50.18 

• RT Systems ADMS-DX3000 (FTDX3000) - Version 5.00.11 

• RT Systems ADMS-991 (FT1-991) - Version 5.00.38 

• RT Systems ADMS-4B (FT-857/FT897) - Version 4.50.39 

• Chirp (various model transceivers) – Version daily-20190925 

Individual lines in import files containing memory channels with receive frequencies greater than 

54MHz, will only be imported into an FT-991 worksheet, and will be ignored if the worksheet is for 

an FTDX1200, FTDX3000 or FTDX5000.  All entries with receive frequencies below 54MHz, can be 

imported into an FTDX1200, FTDX3000, FTDX5000 or FT-991 transceiver worksheet. 

A new blank worksheet must be opened and connected to an FTDX1200, FTDX3000, FTDX5000 or FT-

991 transceiver before the Import… option on the File will be enabled. To import one of the 

supported CSV file formats, select the Import… option from the File menu.  In the file open dialog, 

select the CSV file to be imported, and most importantly select the type of CSV file from the 

dropdown list-box just above the Open pushbutton.  In the following example a CSV Export file from 

the RT Systems ADMS-DX300 software has been selected and the ADMS-DX3000 (*.csv) selection 

has been made in list-box: 
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Click the Open pushbutton, and if the content of the file matches the selected CSV file type, the 

subset of column values that are relevant to FTRestore will be converted and inserted into the 

corresponding channel number in the currently opened worksheet.  Only those lines with a channel 

number between 1 and 99 will be imported, with the rest being ignored. 

Depending upon the model transciever that is the source of the CSV import file data, there may be 

some cases where an operating mode or other column value has no equivalent value in an 

FTDX1200, FTDX3000, FTDX5000 or FT-991 transceiver and a default value is substituted.  Therefore, 

you should examine the results of the import for correctness before attempting to download the 

memory channel details to the attached transceiver. 

The Memory Tag Feature 

The FTDX1200, FTDX3000, FTDX5000, FT-891 and FT-991 model transceivers have a feature whereby 

an alphanumeric label or tag can be appended to individual memory channels.  This is quite a useful 

feature as it makes it easier to recall a channel’s purpose when operating. 

FTDX1200, FTDX3000 and FTDX5000 

Currently there is no support for reading or writing the memory channel tag with the FTDX1200, 

FTDX3000 or FTDX5000 model transceivers.  Refer to the FTDX1200, FTDX3000 or FTDX5000 operating 

manuals for details on how the tag can be entered manually. 

Unfortunately, when you download the worksheet details to the transceiver by selecting the Set 

Memory Channels… option from the Radio menu, and as each memory channel is written, the 

corresponding tag in that memory channel is cleared.  When you upload the memory channel details 

from the transceiver by selecting the Get Memory Channels… option from the Radio menu, there is 

no way to obtain the corresponding tag from each memory channel. 
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The Comments column was added to the worksheet, so you could keep text like the tag, but in the 

worksheet only.  The contents of the Comments column are not sent to the transceiver during a Set 

Memory Channels operation, and they are not overwritten during a Get Memory Channels 

operation.  At least this way you can document the purpose of each memory channel. 

If Yaesu should ever modify the firmware in the FTDX1200, FTDX3000 or FTDX5000 transceivers to 

make it possible to read and write memory channel tags via the CAT command interface, FTRestore 

will be updated so that the Comments column becomes the actual memory channel tag value.  In 

the meantime, remember that this “tag” stays in the worksheet only for these model transceivers. 

FT-991(A) and FT-891 

With version 02-18 or later MAIN firmware for the FT-991, or version 01-06 or later MAIN firmware 

for the FT-991A, Yaesu have implemented a new MT (Memory Channel Write/Tag) CAT command 

that can be used to read and write memory channel tags.  The FT-891 also supports the MT (Memory 

Channel Write/Tag) CAT command. 

When you download the worksheet details to the transceiver by selecting the Set Memory 

Channels… option from the Radio menu, the first 12 characters in the Comments column will be 

used to set the tag.  Any text less than 12 characters in length will be padded out with blanks to form 

a 12-character long tag.  Any text beyond the first 12 characters will be ignored.  When you upload 

the memory channel details from the transceiver by selecting the Get Memory Channels… option 

from the Radio menu, the tag will overwrite the first 12 characters in the Comments column in the 

worksheet.  Any text beyond the first 12 characters will be left untouched. 

The reading and writing of the memory channel tags can be enabled or disabled by a checkbox 

setting in the Preferences dialog.  Refer to Preferences section for further details. 

Cutting, Copying and Pasting Text 

Each of the grid controls that are used in the Memory Channel, Menu Settings and Macro Definitions 

worksheets has its own local clipboard that allows text to be cut, copied and pasted within the grid 

using the Ctrl+X, Ctrl+C and Ctrl+V keyboard shortcuts, or the Cut, Copy and Paste options on the 

Edit menu. 

Text that has been cut or copied onto the Windows system clipboard from another application, 

cannot be pasted into the grid control using Ctrl+V, or by selecting the Paste option on the Edit 

menu.  However, there is a feature in the grid whereby text in the system clipboard can be pasted 

into the grid using a Ctrl+Alt+V keyboard shortcut, or by selecting the Paste System option on the 

Edit menu: 
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The following restrictions apply to system clipboard text being pasted into a grid in FTRestore: 

• There first must be a selection made in the target grid which should be either a single cell, a 

single cell that is being edited, or a range of rows that matches the same number of rows 

(and columns) as the system clipboard data.  Only single cell selections can have system 

clipboard text pasted into a cell in the Comments column of the Menu Settings worksheet 

grid; 

• If a single cell is selected, or is being edited in the grid, and the system clipboard contains 

text, that text will be inserted at the current caret position replacing any currently selected 

text; 

• If a single cell is selected, or is being edited in the grid, and the system clipboard contains 

one or more rows from a Microsoft Excel spreadsheet, or a table in Word, only the first 

column from the first row from the system clipboard will be pasted into the selected cell at 

the caret position replacing any currently selected text; 

• When pasting one or more rows from a Microsoft Excel spreadsheet, or a table in Word, the 

number of rows selected in the grid must be the same, and the number of columns being 

pasted must match the width of the grid. 

Any text cut or copied from a grid in FTRestore, can be pasted into another application via the 

system clipboard. 

Sorting Regular Memory Channels 

The Regular Memory Channel rows in the Memory Channel worksheet grid can be sorted by the Rx 

Frequency column values, by clicking on the Rx Frequency column header, or by selecting the Sort 

option from the Edit menu: 
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If the Memory Group menu setting (Menu number 42 on the FTDX1200, Menu number 41 on the 

FTDX3000, Menu number 36 on the FTDX5000, Menu number 05-09 on the FT-891 or Menu number 

34 on the FT-991) is currently set to DISABLE in the transceiver, then all Regular Memory Channels 

consisting of rows 1 through 99 of the grid will be compressed and sorted by the non-blank, Rx 

Frequency column values, followed by any remaining blank rows.  

If the current Memory Group menu setting is currently set to ENABLE in the transceiver, then the 

five Regular Memory Channel groups consisting of rows 1 through 19, 20 through 39, 40 through 59, 

60 through 79 and 80 through 99 will be similarly compressed and sorted by the non-blank, Rx 

Frequency columns values, followed by blanks rows, with each grouping being done separately. 

The sort direction can be changed alternatively between ascending and descending, by repeatedly 

clicking the Rx Frequency column header, or by selecting the Sort option from the Edit menu. 

PMS Memory Channels in rows P-1L through P-9U of the Memory Channel worksheet grid are not 

included in sort operations, as their positions need to remain fixed. 

IMPORTANT:  Memory Channels can be overwritten but cannot be erased via CAT control.  They can 

only be erased via front panel control, or by carrying out a Memory Reset or a Full Reset of the 

transceiver.  After you have sorted the Memory Channels worksheet, you should carry out a 

Memory Reset before writing the new configuration back to the radio, so any blank rows moved by 

the sort will have the corresponding Memory Channel in the transceiver blank as well. 

Displaying the Menu Settings Dialog 

Select the Menu Settings… option from the Radio menu to open the Menu Settings dialog for the 

transceiver associated with the currently selected worksheet tab in the main window: 
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A blank grid will be displayed the first time the Menu Settings dialog is opened as a menu settings 

file has not yet been created: 

 

Uploading Menu Settings 

Select Get Menu Settings… on the Radio menu in the Menu Settings dialog order to upload the 

current menu settings from the transceiver: 
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You will be warned that the current settings will be overwritten, so click on the Yes button to 

proceed.  As the current menu setting details are uploaded from the transceiver, you will see a 

progress bar and the menu settings being filled in as rows in the grid in the background. If you click 

on the Cancel button, the upload process will stop at the current point in time and the remaining 

menus will not be uploaded: 

 

Once the menu settings have been uploaded, the only changes that can be made to the details in the 

grid is to add text in the Comments column.  This is by design, because at this stage the setting 

values are just the raw responses to the CAT commands sent to the transceiver to obtain the current 

menu settings.  If you are interested in what the values mean, you can refer to the CAT Operation 

Reference Book for your model transceiver that is downloadable from the Yaesu web site. 

The settings have not been translated into selectable dropdown list box values or other style 

controls, but this may be a feature to be added in the future.  In the meantime, FTRestore is still 
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perfectly capable of saving and restoring menu settings between firmware updates and other 

operations that require your preferred menu settings to be quickly restored. 

Therefore, it is recommended that you use the transceiver front panel to make any menu changes as 

desired from the factory defaults, and then perform the Get Menu Settings… upload again to get the 

changes into the grid before saving the contents as a Menu Settings file.  Each time you perform the 

upload, any text in the Comments column for a menu setting will be preserved. 

 

At this stage, it would be advisable to save the values read as a Menu Settings file before continuing 

as the grid should now contain the currently programmed menu settings from the transceiver as set 

for your requirements.  To save the settings select Save As from the File menu, specify a filename 

but don’t change the selected file type and click on the Save button: 
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By default, files will be saved in a folder called FTRestore under the current user’s personal 

Documents folder. 

Comparing Menu Settings 

Select the Compare Menu Settings… option from the Radio menu to see if there are any differences 

between the Menu Settings dialog and the menu settings in the transceiver: 
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A progress bar will be displayed as the rows in the worksheet are compared to the memory channels 

in transceiver.  If you click on the Cancel button, the compare process will stop at the current point 

in time and the remaining menus will not be compared.  If a difference is detected, a dialog will be 

displayed showing the worksheet values on the left and the transceiver values on the right: 

 

In this case, menu setting 006 was changed in the transceiver to 3 seconds before the comparison 

was run. 

The comparison results can be viewed in a Print Preview dialog, or printed, by selecting the 

corresponding option on the File menu in the results dialog. 

Downloading Menu Settings 

Any time you need to restore your desired transceiver menu settings, you can download the details 

to the transceiver by using the previously saved menu settings files and selecting the Set Menu 

Settings… option from the Radio menu: 
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A progress bar will be displayed as the currently menu settings are downloaded to the transceiver.  If 

you click on the Cancel button, the download process will stop at the current point in time and the 

remaining menus will not be downloaded 

CAT Command Terminal 

There is a built-in serial terminal that can be used to send CAT commands to a radio and to display 

any response.  Unless you know what you are doing, it is not recommended to arbitrarily ‘play’ with 

this feature.  You can refer to the CAT Operation Reference Book for your model transceiver that is 

downloadable from the Yaesu web site to determine the correct syntax for the commands and the 

responses. 

Select CAT Command Terminal from the Radio menu to open the terminal window.  If there is an 

opened Memory Channel worksheet currently selected, FTRestore will automatically connect to the 

radio using the COM port settings associated with that worksheet.  In this example the terminal has 

connected on the COM4 port: 

 

Otherwise, click on the Settings pushbutton, specify the desired Port Settings, close the Port Settings 

dialog and then click on the Connect button.  Once connected, the Connect button label will change 

to Disconnect. 

Type the CAT command or commands to be sent to the radio in the CAT Command text box.  

Remember to end each command with a semicolon terminator and do not insert any spaces 

between successive commands (spaces can be valid as a part of some commands such as the 

Contest Memory Keyer commands).  To send the command string to the radio, simply press the 

Enter key on your keyboard, or click the Send pushbutton. 
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In this example, FA;FB; was sent to the transceiver to read the current VFO A and VFO B frequencies: 

 

Any commands sent to the radio will be displayed in a blue font in the rich text control, and 

responses received from the radio (if any), will be displayed in a red font.  In this example the 

current VFO-A frequency is 7.088MHz and the current VFO-B frequency is 7.000MHz. 

If the Clear command sent checkbox is ticked, the CAT Command textbox will be cleared each time 

the command string is sent.  Otherwise, the CAT Command textbox contents will be left unaltered 

and can be manually cleared or altered and sent again as desired. 

The Clear pushbutton clears the rich text control that displays the sent and received text. 

Select the Exit option from the File menu to close the CAT Command Terminal and return to the 

FTRestore main window. 

Select the Macro Definitions… option from the File menu to create and maintain definition files used 

to populate the Macro Toolbar which is the gray bar just below the menu: 
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The Macro Definitions editor is like a Memory Channel or Menu worksheet editor and has similar File 

and Edit menu options. 

Enter up to 12 characters for the text that you wish to appear as the label for a macro toolbar 

pushbutton in the Label column and enter up to 100 characters for the CAT command string to be 

sent by that pushbutton in the Commands column.  You enter whatever text you like in the 

Comments column which is purely for documentation purposes. 

In this example, above, the first macro pushbutton will be labelled KM1 – CQ and will send the KM1; 

CAT command string to the radio to set CW Contest Memory Keyer number 1 to the value used as an 

example in the FTDX1200, FTDX3000, FTDX5000, FT-891 and FT-991 transceiver Operating Manuals.  

The second macro pushbutton will be labelled Power Off and will send the PS0; CAT command to 

power of the radio. 

To save a definition file, select Save As from the File menu, specify a filename but don’t change the 

selected file type and click on the Save button.  You can enter a maximum of 10 macro definitions in 

a macro definition file, but you can have an unlimited number of definition files. 

The most recently created or opened macro definition file will be used to populate the macro 

toolbar each time the CAT Terminal Window is opened. 

In this example the macro definition file described above has been used and the first and second 

macro pushbuttons have been pressed: 
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The KM1CQ CQ CQ DE W6DXC K; command string sets the contest memory keyer value and the 

absence of any response indicates that the command was accepted.  The PS0; command string turns 

the radio off and once again the absence of any response indicates that the command was accepted. 

It would be obvious by the radio turning off that the command was accepted as well! 

Preferences 

The FTRestore application preference settings dialog can be displayed by selecting the Preferences 

option on the Settings menu. 

 

The Save open worksheet tabs option determines whether FTRestore will save all currently opened 

worksheets or not when the application is closed.  The next time the FTRestore application is run it 
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will automatically open the worksheets.  Tick this checkbox setting to save the worksheet list when 

the application closes. 

The Default Worksheet Type option is used to specify the Microsoft Excel spreadsheet file format to 

be selected by default in the File Save (and File Open) dialog.  You can change the type in the actual 

File Save/Open dialogs each time you save/open a worksheet file, or you can set a new default 

preference with this setting.  You would only change the Default Worksheet Type setting to a 

different value as a convenience when saving files for use with another application that cannot read 

the current file format.  Otherwise, the value for this preference setting doesn’t matter as FTRestore 

can read any of the types in the Default Worksheet Type list box. 

The Progress Style option is used to select between Percentage completed, or Step Number of total 

steps, to be displayed on the progress bar when performing the various get, set and compare 

operations. 

The FT-991(A) Mobile Noise Reduction feature was added in response to a user who owns a restored 

classic motor vehicle, originally built in the late 1940s, in which the ignition noise is considerable.  He 

wanted the Noise Blanker and Digital Noise Reduction to be automatically turned on whenever he 

selected a previously programmed memory channel whilst operating mobile. 

This is achieved by selecting the Noise Blanker and/or Digital Noise Reduction checkboxes as desired 

in the Preferences dialog before using the Set Memory Channels feature in FTRestore.  As each 

channel is being written to the FT-991, and the mode is not one of the FM modes, the Noise Blanker 

and Digital Noise Reduction settings will be explicitly set to on in the channel by the corresponding 

check box being selected in the Preferences dialog.  The Noise Blanker Level cannot be stored in a 

Memory Channel, so the level needs to be set while operating the radio.  The DNR level is stored in 

the memory but can only be set via the FT-991 front panels control.  So, make sure you set the DNR 

Level before you run the Set Memory Channel operation. 

The Noise Blanker and Digital Noise Reduction are disabled in the FT-991 itself for any of the FM 

modes. 

The FT-991(A) Memory Channels feature was added after Yaesu upgraded the firmware to allow the 

memory channel tag to be read and written by the CAT command interface.  The Enable Memory 

Tags checkbox needs to be checked for the memory channel tags to be read and written.  If the 

Enable Memory Tags checkbox is left unchecked, the memory channel tag will not be saved or 

restored.  Refer to The Memory Tag Feature topic for further details. 

Note: the MT (Memory Channel Write/tag) CAT command is available in the FT-891, but only 

available in MAIN firmware version 02-18 or later for the FT-991, or version 01-06 or later for the FT-

991A only.  It is not currently available in the FTDX1200, FTDX3000 or FTDX5000 model transceivers. 
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Setting Time and Date 

Once you have opened a worksheet and FTRestore has automatically detected the transceiver model 

connected to the specified COM port, the Set Radio Time/Date menu option will be enabled on the 

Settings menu.  This will set the current Date and Time UTC, and the local time offset in multiples of 

30 minutes, in a FT-991 transceiver using the current time and date from the operating system. 

In the case of an FTDX1200, FTDX3000 or an FTDX5000, only the time can be set in that transceiver.  In 

this case, you will be prompted as to whether you want the clock in the transceiver to be set to Time 

UTC or your local time: 

 

Select Coordinated Universal Time or your local time with the radio buttons and click on the OK 

button to set the time in the FTDX1200, FTDX3000 or FTDX5000 transceiver. 

Check for Updates 

You can check periodically for new releases of FTRestore by selecting Check for Updates… from the 

Help menu: 

 

If you are currently running the latest release of FTRestore, there is no further action required other 

than to click the OK button: 
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If a later release of FTRestore has been released, then details of the new release will be displayed in 

a dialog like the following: 

 

If you wish to postpone downloading the latest release, click on the No button.  We would always 

encourage our users to download the latest release as it will most likely contain new features and/or 

fixes for defects. 

To download and install the latest release, click on the Yes button.  A progress dialog will display as 

the installation program is downloaded: 

 

Once the installation program has finished being downloaded, the following dialog will be displayed: 

 

Once again you can postpone installing the latest release by clicking on the No button.  To install the 

latest release, click on the Yes button. 
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The currently running version of FTRestore must be closed for the latest version to be installed.  If 

you have any modified Memory Channel worksheets currently open, you will be given an 

opportunity to save them before FTRestore is automatically closed and the installation program is 

launched. 

Once the installation program starts you will be warned that the current version will need to be 

uninstalled before continuing: 

 

Click on the Yes button for the uninstallation to continue at which time a further confirmation dialog 

from will be displayed: 

 

Click on the Yes button and all program files (executables and assemblies) from the current version 

will be uninstalled.  All Memory Channel worksheets and Menu Settings files will not be removed. 

Once the removal of the current version has completed, the installation of the new version will 

proceed in a similar way as described previously in the Installation section. 

If a new release involves changes in the layout of memory channel worksheets, existing ones will be 

automatically updated the next time they are opened – either when they are loaded as FTRestore 

starts, or when they are manually opened by selecting Open… (Ctrl+O) on the File menu. 

Additional Notes 

Prior to applying firmware upgrades to either of these transceivers, it is highly recommended that a 

copy of the memory channels be uploaded to an FTRestore worksheet and saved, and a copy of the 

menu settings be uploaded and saved as a menu settings file.  After the firmware upgrade to the 

transceiver is complete, the memory channels and menu settings can be downloaded again. 
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IMPORTANT:  Memory Channels can be overwritten but cannot be erased via CAT control.  They can 

only be erased via front panel control, or by carrying out a Memory Reset or a Full Reset of the 

transceiver.  If you intend deleting any memory channels within FTRestore, then carry out a Memory 

Reset before writing the new configuration back to the radio, and NOT BEFORE getting the memory 

channel details from the transceiver 
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Installing the Microsoft .NET Framework 4.5.1 

1. The FTRestore installation program will open the web browser at the correct page, or you can 
manually enter http://www.microsoft.com/en-us/download/details.aspx?id=40773 , to run the 
Microsoft .NET Framework 4.5.1 web installer. 

2. Click on the Download button to start the download: 
 

 

3. If you get the security warning from Internet Explorer, click where it says Click here for options 
and select Download File… from the menu: 
 

http://www.microsoft.com/en-us/download/details.aspx?id=40773
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4. The web installer will download and when the following prompt appears, click on the Run 
button: 
 

 

5. When the web installer runs, the following prompt or something similar may appear.  Click on 
the Run (or Yes) button: 
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6. Accept the license terms by checking the box and then click Install: 
 

 

7. The web installer will then start downloading and installing the Framework and will display the 
follow progress dialog: 
 

 

8. Wait until the installation is complete and then click the Finish button: 
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The installation of the Microsoft .NET Framework 4.5 is complete. 


